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2008 will be remembered for provid-
ing us all with a political, historical, 
and financial roller-coaster ride.  
However, it will also be remembered 
as a year of great growth and 
achievement here at Online Business 
Applications. We welcome the start of 
a new epoch at our Woodridge home.

I would like to thank all of our employ-
ees and clients for their input into our 
business during what has been at 
times a challenging year.  I make 
particular note of the professionalism 
of our staff and the image we 
continue to convey to our customers.

As 2009 approaches, I would like to 
focus on what we are currently 
striving to achieve in order to "stay 
ahead of the game" in continuing to 

provide the Medical Communication 
community with support and products 
that fulfill its needs.

As our business continues to grow, 
we are constantly looking to add to 
the list of talented people that make 
up our team here in Woodridge.  We 
have recently added four individuals 
in the areas of Support, Development, 
Validation and Quality Assurance, 
each bringing their own unique skills, 
thoughts, ideas and identity to the 
organization. I wish our new and 
existing staff good luck and every 
success in 2009.

Additionally, early in the new year we 
will be adding to our staff in other 
areas of the organization, particularly 
those positions involved in supporting 
the needs of our clients at their 
individual sites. We will keep everyone 
informed of all the latest talent joining 
the team via this newsletter and 
through the additional services we 
hope to offer.

The senior management team at OBA 
focuses on continual improvement of 
all aspects of the business, particu-
larly focusing on providing career 
paths for our staff as a way to best 
build a strong, multi-skilled, vibrant 
organization focused on customer 
service.  This is demonstrated by 
Mike Green, who has risen through 
our ranks to attain the position of 
Support Manager, and Michael 
Holzmeister, who now works largely in 
Development in addition to using his 
experience and knowledge of the 
Medical Information industry to assist 
in the installation processes for our 
new clients.

Additionally, Stewart Hartz, after 
originally starting in Support, has 

moved on to become our IT manager, 
playing a key role in building the 
company’s technical infrastructure.  
Andy Crawford, who has recently 
taken on the role of Senior IRMS 
Education Specialist, is now also 
managing his department. All of these 
people, whilst building their personal 
portfolio of skills, continue to demon-
strate the spirit management wishes 
to engender throughout our company.

As many of our clients are aware, the 
move from our old location in Lemont 
to our new office in Woodridge has 
provided us an improved technical 
infrastructure, as well as room for 
growth at a time when many organi-
zations are downsizing.  Our contin-
ued investment in our organization 
shows that both Dennis and I, along 
with our other Vice Presidents, Joe 
Pierce and Bill Nabors, have faith in 
our ongoing ability to grow the 
company in 2009 and beyond. We 
have many of our existing and loyal 
clients to thank for continuing to help 
us improve our system and for acting 
as advocates of our company with 
some of our newest clients.

As we go forward into a new year, I 
feel our customers can be assured 
that our organization will continue to 
show sound judgment operationally, 
tactically and strategically. Online 
Business Applications is confident 
that we can continue to rely on our 
strong and loyal clients to support us 
well into the future.

Best Wishes for the season,
David Hayward

Executive Vice President  
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As our company continues to grow and more people join the OBA Team, I would 
like to point out some structural changes taking place within our organization for 
the start of the New Year.

In Sales and Marketing, Joe Pierce will be focusing on new sales opportunities.  
While I will be the primary contact for any sales related questions including 
training, custom development, consulting services, new licenses and additional 
modules: AE, PC, QA, CM.  
I can be reached at 1-630-243-9810 ext 220 or at kirsten.carson@irmsonline.com 

David Hayward will be concentrating his efforts in the area of Business Administra-
tion and as such, Mike Green will be handling Account Management duties. He 
will still be Support Manager and will be combining these duties going forward.
Mike Green can be reached at 1-630-243-9810 ext 207 or at 
mike.green@irmsonline.com
 

Just a reminder, OBA moved recently and we want to make sure 
everyone’s Accounting departments have the correct address:

Online Business Applications
9018 Heritage Parkway
Suite 600
Woodridge, IL 60517

1(630) 243-9810
(All of our phone numbers remain the same)

CBI 8th Annual Pharmaceutical 
Contact Center Event
Philadelphia, PA
January 26-27, 2009
http://www.cbinet.com

Left Coast Medical Meeting
hosted by Genentech Medical 
Communications
San Francisco
January 30, 3009

CBI 2nd Annual 
Bio/Pharmaceutical and Medical 
Device Forum on Knowledge 
Management for Medical Affairs
Philadelphia, PA
February 9-10, 2009
http://www.cbinet.com

DIA 22nd Annual Conference for 
Electronic Document Manage-
ment
Philadelphia, PA
February 10-12, 2009
http://www.diahome.org

IRMS Spring Workshop
Hilton Head Island, SC
February 27-28, 2009
www.irmsonline.com

DIA 20th Annual Workshop on 
Medical Communications
Hilton Head, SC
March 2-4, 2009
http://www.diahome.org

DIA 21st Annual EuroMeeting
Berlin, Germany 
March 23-25, 2009 
http://www.diahome.org

DIA 45th Annual Meeting
San Diego, CA
June 21-24, 2009
http://www.diahome.org

Upcoming

Events
MAKING CHANGES

IRMS Spring Workshop
Friday February 27, 2009
  &
Saturday February 28, 2009
Hilton Head, South Carolina

New agenda format for 2009

Hilton Head Marriott Resort 
& Spa
One Hotel Circle
Hilton Head Island, SC 29928
Phone (843) 686-8478
Group Code:  onbonbc

Register at www.irmsonline.com

2009 IRMS Workshop

By Kirsten Carson



Targanta Therapeutics
Targanta Therapeutics Corporation is a biopharmaceutical company focused on 
developing and commercializing innovative antibiotics to treat serious infections in 
the hospital and other institutional settings. Targanta's strategy is to develop 
oritavancin into a leading therapy worldwide for the treatment of serious gram-
positive infections, initially for the treatment of cSSSI and subsequently for other 
indications

Wyeth France 
Wyeth has a long history of pioneering developments in pharmaceuticals and 
biotechnology, with leading products in the areas of women’s health care, neuro-
science, musculoskeletal disorders, vaccines and infectious disease, hemophilia, 
and oncology. Wyeth also is a leader in the development of nutritionals.  Wyeth 
improves the lives of millions of people around the world with its outstanding 
products. And new, innovative medicines are on the way. With research and 
development (R&D) programs focused on small molecules, vaccines, and biotech-
nology, Wyeth is exploring more than 90 new therapies for medical conditions 
such as diabetes, breast cancer, multiple sclerosis, Alzheimer’s disease, and 
schizophrenia.

Celgene Global
Celgene is a multinational biopharmaceutical company committed to improving 
the lives of patients worldwide.  Celgene seeks to deliver truly innovative and 
life-changing drugs for our patients. Their mission as a company is to build a 
major global biopharmaceutical corporation while focusing on the discovery, the 
development, and the commercialization of products for the treatment of cancer 
and other severe, immune, inflammatory conditions.

Novartis Canada
Novartis' dedication to scientific research, imagination, and new technologies has 
led to the creation of thousands of groundbreaking products and services in the 
areas of pharmaceuticals, nutrition, eye-care, and animal health.  Novartis Phar-
maceuticals Canada Inc. is a leading research-based company with a wide-
ranging program for the development and marketing of innovative prescription 
medications in Canada. The Company's national head office building, completed 
in 2003, is located in Dorval, Quebec.

New 
Clien

ts

Eric Oles is a graduate of the 
University of Central Florida with a 
Bachelors of Science in Marketing 
and Health Service Administration.  
Eric is a Client Services Specialist 
with previous experience working in 
customer support.  In his spare 
time Eric enjoys spending time with 
his family, hanging out with friends, 
and loves sports.
  

Mike Luczak joined OBA as a 
Developer and has been in the 
industry for over 8 years.  
Mike has a son Mikey who is 4 and 
has Mike’s blue eyes! When he isn’t 
spending time with his son he is in 
the gym or hanging out with friends.  
Mike looks forward to a wonderful 
time here at OBA.

Rodney Fiene joined OBA as a 
member of the Quality Assurance 
team.  Rodney holds a BA degree 
from Loyola University and is a 
software quality professional with 
over 15 years of experience, and he 
is a certified Six Sigma Green Belt.  
In his spare time he enjoys fishing 
and long walks with his family and 
four dogs.  
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Step 3: Set up a simple standard 
document

a)  Return to Document Mainte-
nance, but leave the You Are Working 
With option set to Standard. 

b)  Click the New document button 
on the bottom navigation tool. 

c)  Enter a Doc ID and Title.

d)  Click Edit. The system prompts 
you to create a new word processing 
document; click Yes. 

e)  Insert a merge field using the 
Client Data memo field name you 
created in Division Parameters. See 
the Field Code Guide for details on 
inserting merge fields.

f)  Add additional text to the docu-
ment around the memo merge field, if 
needed. 

g)  Save and Close the word docu-
ment. 

h)  Change the document’s Status to 
Approved. 
 

Step 4: Select the Memo Content

a)  In a case record, click the Client 
Data button.
 
b)  Click the Content pick list 
button above the Memo field and 
select the e-mail document created 
above.
 
c)  The system builds the Memo 
text based on the selected e-mail 
template. 

d)  Close Client Data.

 
 

Step 5: Build the Response Letter

a)  Click the Letters button to begin a 
new case response letter record. 

b)  Optional: If you want to render the 
e-mail as a stand alone response 
letter, without an opening or closing, 
change the Letter Format option to 
one defined in the Standalone format 
style (see IRMS Document Manage-
ment Guide for details on Letter 
Formats). 

c)  Click the Document Title pick list 
and select the Standard type docu-
ment created above.
 
d)  If any additional Enclosure records 
are needed, click the Enclosure pick 
list and select the appropriate one. 

e)  Click the Merge button. 

f)  After IRMS completes the letter 
merge, click Edit or View to review the 
results. 



Support Center

Each quarter when newsletter time rolls around, we here in the Support Depart-
ment aim to provide articles that not only inform, but also offer tips and techniques 
that highlight the ease of use and simplicity of IRMS.  This quarter, we decided 
that the best way to do this was to discuss the ways that some of the most 
common software errors may be quickly and easily remedied.

Error #-2147417851: The operation failed due to network or other 
communication problems. Check your connections and try again.

MS Outlook options may not be set properly.  Click the Tools menu and select 
Options.  On the Mail Format tab, uncheck the options for "Use Microsoft Office 
Word 2003 to edit e-mail messages" and "Use Microsoft Office Word 2003 to read 
Rich Text e-mail messages" (the text of these options may vary slightly depending 
on the version of Outlook being used).

Note: If IRMS is running in a Terminal Server or Citrix configuration, this change 
must be made in Outlook on the server, not on the user's machine.

 Error #2467: The expression you entered refers to an object that is 
closed or doesn't exist. 

The user's IrmsProg may have become corrupted, and should be refreshed.  To do 
this, perform the following steps: 
1. In IRMS, click the Help menu, and select the "About IRMS" option. 
2. Click the "Refresh Your IrmsProg" button. 
3. Click OK, and then click Close. 
4. Exit IRMS, then log back in. 

Error #2753: A problem occurred while IRMS was communicating with 
the OLE server or ActiveX Control 

The user may have tried to view/edit an IRMS Document or Letter while MS Word 
was displaying a dialog box.  Log out of IRMS completely, and then attempt to 
locate the open dialog box by pressing Alt-Tab.  Close the dialog box, and then 
attempt to view the document again.

Error #2455: You entered an 
expression that has an invalid 
reference to the property 
Form/Report.

 The user may be attempting to 
navigate through records in IRMS too 
quickly.  As a general rule, no action 
in IRMS should be performed when 
the Status Bar (located in the lower-
right corner of the main IRMS 
window) indicates that an action is 
already being performed.  Consider 
other methods, such as Case Query 
or Datasheet View, as an alternative to 
navigating through many records 
when trying to locate a particular 
case.

Error #3157: ODBC 
(Verbiage following ODBC 
may vary)

In order to recover from this error, the 
recommended course of action is for 
all users to log out of IRMS.  Once all 
users are confirmed logged out, they 
can then log back in to IRMS, one at 
a time if possible.

Error #3146: ODBC--call 
failed. 

The user's IrmsProg may have 
become corrupted, and should be 
refreshed.  To do this, perform the 
following steps: 
1. In IRMS, click the Help menu, and 
select the "About IRMS" option. 
2. Click the "Refresh Your IrmsProg" 
button. 
3. Click OK, and then click Close. 
4. Exit IRMS, then log back in.

Technical Support Insight on IRMS Common Errors
By Kimberly Utley



IrmsMailOutlook Component Unavailable 
IRMS was not able to create a requested object.
Object: IrmsOutlookMail.IrmsMailItem

This error is related to a file called CDO.DLL, and is usually caused because the 
file is either missing or unregistered.  It can normally be resolved by performing the 
following steps:
1. If the CDO.DLL file is not in the proper location (C:\Program Files\Common Files
    \System\MSMAPI\1033), obtain the file from another machine, and place it in 
that location.
2. Click the Windows Start menu, and select the Run option.
3. Type or paste the following into the "Open" box, and click OK:
    regsvr32 "C:\Program Files\Common Files\System\MSMAPI\1033\CDO.DLL"
4. Click OK in response to the message confirming a successful registration.

GridEx Control not found 
Error Registry key -201 
Invalid or missing GridEX20.ocx 

One of the following reasons is the cause: 
1)  GridEx20.ocx file is not registered.  In a Citrix setup, an admin must register the 
file on the server.  For a Client/Server setup, the file must be registered on the local 
machine.

2)  You don't have permissions to the GridEx20.ocx file.  All users should have 
Modify rights to this file. 

3)  The GridEx20.ocx file is not installed & registered.  It should be in 
C:\Windows\System32. 
If you can't find it in your CD, you can download it from here: 
http://www.irmsonline.com/web/datau/Gridex20.zip 

Error #-2147467259: Can't create file 

 

This error usually appears when trying to email.  The User’s outlook temporary files 
need to be purged.  To find and delete the temp outlook files: 

Step 1: Locate the folder.
The folder location is stored in the registry in the following key: 
Outlook 97 
HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\Security 
Outlook 98 
HKEY_CURRENT_USER\Software\Microsoft\Office\8.5\Outlook\Security 
Outlook 2000 
HKEY_CURRENT_USER\Software\Microsoft\Office\9.0\Outlook\Security 
Outlook 2002/XP 
HKEY_CURRENT_USER\Software\Microsoft\Office\10.0\Outlook\Security 
Outlook 2003 
HKEY_CURRENT_USER\Software\Microsoft\Office\11.0\Outlook\Security 
Outlook 2007 
HKEY_CURRENT_USER\Software\Microsoft\Office\12.0\Outlook\Security 

Step 2: Get to the folder. 
-  Open the OutlookSecureTemp-
Folder registry key from the location 
provided in Step 1. 
-  Copy the path from the key. 
-  Open Explorer 
-  Paste the address in the Address 
Bar and press Enter 

Error #3048: Cannot open any 
more databases. 

Have the User refresh their 
IRMSPROG. 
To do this, perform the following 
steps: 
1. In IRMS, click the Help menu, and 
select the "About IRMS" option. 
2. Click the "Refresh Your IrmsProg" 
button. 
3. Click OK, and then click Close. 
4. Exit IRMS, then log back in.

 
Error #3051: The Microsoft 
Jet database engine cannot 
open the file 

This is a File/Directory permissions 
issue.  Verify that User has 
Read/Write/Execute rights to their 
Local folder, as well as the IRMS 
System folder.

We hope that you have found this 
informative and will find it useful in the 
future.  As always, if you receive an 
error or are having any difficulties 
whatsoever, you should never hesitate 
to contact Technical Support.  We are 
always here and happy to assist you. 

www.irmsonline.com



Share your IRMS experiences 
with the Online community. 
Are you interested in writing an article 
and getting it published in Inside 
Online?  We encourage you to share 
with us your thoughts, ideas and 
different IRMS experiences.  Tell us 
about how you are using IRMS in a 
unique way.  Share your company’s 
experience with deploying IRMS 
globally. 

Some recent guest writers and 
articles include:

Going Global by Victoria Vowels of 
Merck Serono International SA

Copyright for Business Profession-
als by Copyright Clearance Center

Capturing Conference Medical 
Inquiry Requests at the Medical 
Affairs Booth by Amyas Huston of 
Cubist Pharmaceuticals

User Driven Design by Tim 
Batchelder of EMD Serono
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obaEC
• Education Center •

Class Schedule

Febuary 16 - 17  Basic IRMS
   Case Entry, Response Letters,
   Query & Reporting

March 16 - 17  Administrator
   Tables, System Config,
   Document Maintenance

April 13 -14  Advanced IRMS
   Business Rules, Data Protection,
   Advanced Doc Maintenance and more.

May 11 - 12  Basic IRMS
   Case Entry, Response Letters,
   Query & Reporting   

June 8 - 9  Administrator
   Tables, System Config,
   Document Maintenance

training@irmsonline.com
For more information please contact:

www.obaec.comD
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